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LDAP Directory on Yealink IP Phones

Introduction

LDAP stands for Lightweight Directory Access Protocol, which is a client-server protocol for
accessing a directory service. LDAP is a directory service protocol that runs over TCP/IP. The
nitty-gritty details of LDAP are defined in RFC 1777 "Lightweight Directory Access Protocol”.

The following gives an overview of LDAP from a user's perspective.
What kind of information can be stored in the directory?

The LDAP information model is based on entries. An entry is a collection of attributes that has a
globally-unique Distinguished Name (DN). The DN is used to refer to the entry unambiguously.
Each of the entry's attributes has a type and one or more values. The types are typically
mnemonic strings, like "cn" for common name, or "mail" for email address. The syntax of values
depends on the attribute type. For example, a cn attribute might contain the value "Babs

Jensen”. A mail attribute might contain the value "babs@example.com".
How is the information arranged?

In LDAP, directory entries are arranged in a hierarchical tree-like structure. Traditionally, this
structure reflected the geographic and/or organizational boundaries. Entries representing
countries appear at the top of the tree. Below them are entries representing states and national
organizations. Below them might be entries representing organizational units, people, printers,
documents, or just about anything else you can think of. The following shows an example of

LDAP directory tree using traditional naming.
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LDAP enables you to locate organizations, individuals, and other resources such as files and

devices in a network, whether on the Internet or on a corporate intranet, and whether or not you

know the domain name, IP address, or geographic whereabouts. An LDAP directory can be
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distributed among many servers on a network, then replicated and synchronized regularly. LDAP
is particularly useful for storing information that you wish to read from many locations, but

update infrequently.

This guide provides configurations on the LDAP server and IP phones, and applies to the
following Yealink IP phones:

e  CP860 IP phones running firmware version 71 or later

e  SIP-T48G, SIP-T46G, SIP-T42G and SIP-T41P IP phones running firmware version 73 or later

° SIP-T58V/A, SIP-T56A, SIP VP-T49G, SIP-T40P, SIP-T29G, SIP-T27P, SIP-T23P/G, SIP-T21(P)
E2, CP960 and W56P IP phones running firmware version 80 or later

. SIP-T54S, SIP-T52S, SIP-T48S, SIP-T46S, SIP-T42S, SIP-T41S, SIP-T40G, SIP-T27G, SIP-T19(P)
E2, CP920, W60 and W52P IP phones running firmware version 81 or later
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Installing and Configuring the LDAP Server

An LDAP server is essentially a bit like an SQL server, which is mainly used for storing/retrieving
information about people (such as contacts). The configuration settings on the phone will be

altered depending on how the LDAP server is configured.

Before using LDAP feature on IP phones, you must make sure the LDAP server is prepared
properly, otherwise you need to install and configure an LDAP server. This chapter shows you
how to install and configure an LDAP server. We recommend you to use the OpenLDAP,
Microsoft Active Directory, Microsoft Active Directory Application Mode (ADAM) or Sun One
Directory Server on Windows system.

OpenLDAP

Installing the OpenLDAP Server

This section shows you how to install an OpenLDAP server on Microsoft Windows 2007 system.
The OpenLDAP server software is available for free. You can download it from

http://www.userbooster.de/en/download/openldap-for-windows.aspx?l=en.

To install the OpenLDAP server:

1. Double click the OpenLDAP application to start the installation. You will be prompted for

the installation.

2. Click Yes to continue the installation.

3. Follow the default settings and click Next until the Destination Folder screen appears.


http://www.userbooster.de/en/download/openldap-for-windows.aspx?l=en
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4. Click Change to locate the installation path from local computer system and then click
Next.

You need to remember the installation path (e.g., D:\OpenLDAP) located here.

The screenshot for reference is shown as below:

5. Follow the default settings and click Next until the Ready to install OpenLDAP for

Windows screen appears.

OpenlLDAP Instaflation

Ready to install OpenlLDAP for Windows

Ciet install o begn fe extaleon Oich Bmck 20 v a dhangs ey o oo
20 Wi

s Boad Map

6. Click Install to start the installation.
7. Click Close to exit the Setup Wizard.

For more information on how to install the OpenLDAP server for windows, refer to the website
online:

http://www.userbooster.de/en/support/feature-articles/openldap-for-windows-installation.aspx


http://www.userbooster.de/en/support/feature-articles/openldap-for-windows-installation.aspx
http://www.userbooster.de/en/support/feature-articles/openldap-for-windows-installation.aspx
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Configuring the OpenLDAP Server

Editing the slapd.conf File

Access the OpenLDAP installation path. Edit the manager information for LDAP.
1. Open and edit the slapd.conf file using your favorite text editor.
Find the commands
Suffix “"dc=maxcrc, dc=com™
Rootdn "cn=Manager,dc=maxcrc,dc=com"”
Suffix defines the components of the domain name.
Rootdn defines the manager as a management user for accessing the LDAP server.
For example:
Suffix "dc=yealink,dc=com™
Rootdn "cn=Manager,dc=yealink,dc=com "

The suffix line means that the domain name of the LDAP directory is yealink.com. The

Rootdn line defines a management user named as Manager.

If the domain name contains additional components, for example, yealink.com.cn, the suffix

line will be edited as below:
Suffix "dc=yealink,dc=com,dc=cn"
Rootdn “cn=Manager,dc=yealink,dc=com,dc=cn"

2. Double click slappasswd.exe to modify the user password for the management user. Type

the new password twice.

Starting the Slapd Service

To start the slapd service:

1. Click Start->Run.
2. Enter cmd in the pop-up dialogue box and click OK to enter the command line interface.

3. Access the server installation path. For example, execute the following commands to access
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the server installation path at D:\OpenLDAP.

iNUzsers \wilf215 >d:

D:s\ocd OpenlbnP

P \OpenLDAPY

4. Execute the command slapd.exe -d 1 -f ./slapd.conf to start the slapd service.

Haers wilN2155d43

cd OpenLDAF

D: \OpenLDAP s Lapd . exe

If the service runs successfully, you can find the prompt “slapd starting”.

The screenshot for reference is shown as below:

;0 CAWindows\systemi32ACMD.exe - slapd.exe +d 1 f felapd.conf
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Please do not close this window to make sure the LDAP server keeps running.

Adding the Initial Entry to the LDAP Directory

You can add the initial entry to the LDAP directory by using the LDIF file. Create a new text
document, then modify the filename extension as Idif and place the document to the OpenLDAP
installation path. For example, create a text document named as test.txt, right click the test.txt
document and then select to rename it, modify the filename extension as Idif. Open the LDIF file
with your favorite text editor and input the corresponding content. The following shows an

example of the content of the LDIF file:

dn: dc=yealink,dc=com
objectClass: top
objectClass: dcObject
objectClass: domain

dc: yealink
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dn: ou=roles,dc=yealink,dc=com
objectClass: top
objectClass: organizationalUnit

ou: roles

dn: ou=people,dc=yealink,dc=com
objectClass: top
objectClass: organizationalUnit

ou: people

dn: cn=Test Users,ou=roles,dc=yealink,dc=com
objectClass: groupOfUniqueNames
cn: Test Users

uniqueMember:

uid=sspecial,ou=people,dc=yealink,dc=com

uniqueMember:

uid=jbloggs,ou=people,dc=yealink,dc=com

dn: cn=Special Users,ou=roles,dc=yealink,dc=com
objectClass: groupOfUniqueNames
cn: Special Users

uniqueMember:

uid=sspecial,ou=people,dc=yealink,dc=com

dn: cn=Admin Users,ou=roles,dc=yealink,dc=com
objectClass: groupOfUniqueNames
cn: Admin Users

uniqueMember:

uid=admin,ou=people,dc=yealink,dc=com

dn: uid=admin,ou=people,dc=yealink,dc=com
objectClass: person

objectClass: inetOrgPerson

cn: State App

displayName: App Admin

givenName: App

mail: admin@fake.org
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sn: Admin
uid: admin

userPassword: adminpassword

dn: uid=jbloggs,ou=people,dc=yealink,dc=com
objectClass: person

objectClass: inetOrgPerson

cn: Joe Bloggs

displayName: Joe Bloggs

givenName: Joe

mail: jbloggs@fake.org

sn: Bloggs

uid: jbloggs

userPassword: password

dn: uid=sspecial,ou=people,dc=yealink,dc=com
objectClass: person

objectClass: inetOrgPerson

cn: Super Special

displayName: Super Special

givenName: Super

mail: sspecial@fake.org

sn: Special

uid: sspecial

userPassword: password</span>

To add the initial entry using the test.ldif file:

1. Click Start->Run.
2. Execute cmd in the pop-up dialogue box and click OK to enter the command line interface.

3. Access the server installation path. For example, execute the following commands to access
the server installation path at D:\OpenLDAP.
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4. Execute the command slapadd -v -l ./test.Ildif to add the initial entry.

The screenshot for reference is shown as below:
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D:\OpenLDAP

Configuring the LDAPExploreTool2

The LDAPExploreTool2 application supports running on Windows system. The application is a
graphical LDAP tool that enables you to browse, modify and manage contact entry on LDAP

server.

If you have an LDAPExploreTool2 application installed on your computer, open it now, otherwise,
download the application from http://Idaptool.sourceforge.net/. And then complete the

installation following the wizard.

Creating a Configuration

To create a configuration:

1. Double click the LDAPExploreTool2.exe to run the application.

2. Click File->Configurations.

T LDAPExplorerToo! 2 2 |
[File] Tacis

Open st corfiguration

Conhiguratices

Qut

3. Click New to create a new configuration.
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4.

5.

Enter a name in the Configuration name field under the Configuration tab.

 Configuration =5

Configuration | Servar | Connecton | Option | 554/ TLS

Configuration namae (DA

Ok J Canced

Enter the domain name or IP address of the LDAP server in the Server name or IP field
under the Server tab. Check the checkbox of Use default port for the Server port and

Server SSL port.

| Configuration (=5

Configuration  Sefver | Connecton | Option | 554/ TLS

Server nama of P 1036128

Sarver port ) ¥ Use dafault port
Sarver SSL port | 636 ¥ Use dofault port
Version

" 302

Test connacton |

Ok J Canced

Enter the user DN and password in the User DN and Password field under the Connection

tab.

The user DN and password correspond with the Rootdn and Rootpw defined in the

slapd.conf file.
For example, according to the manager information defined in the slapd.conf file:
Rootdn "cn=Manager,dc=yealink,dc=com"”

Rootpw secret

10
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Enter cn=Manager,dc=yealink,dc=com in the User DN field and secret in the Password

field under the Connection tab.

Configuration 5

Configuration | Seevar  Connecten | Option | S5L/TLS |

User DN [(yeamkocscom | Anonymous logn
Password [eeeeas W Store password
Use SSL port
Yet & No
Use TLS
~ Yes & Mo {715 & only used

on non SSL ports)

Base DN | demyenink demai | Guess value

Test connection |

ok | cancet |

7. Click Guess value to fill the Base DN automatically.

8. Click Test connection to test the connection to the LDAP server. If you encounter an error
or warning during the test, you need to resolve the error or warning first according to the

prompt, and then retry to test the connection.

9. Click OK to accept the change.

Adding Entries

To add entries:

1. Click File->Configurations, select the configuration created above, and then click Open.

The screenshot for reference is shown as below:
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2.

5.

Right click the root entry, and then select Add to add a new entry.

T D T §
e Tooh

Enter the desired values in the corresponding fields.

Parent DN: It will be automatically generated according to the server configuration.

Entry RDN: The format is cn=XXX. This is a unique identifier for each entry.

Object Class (from schema): Select the structure class which the entry belongs to. Each

structure class has its own must attributes and may attributes. For example, we select

person from the pull-down list of Object class (from schema).

Select the desired attributes for object class.

Must attributes: Double click attributes to add them to the entry node. All attributes listed

in the Must attributes field must be added and each value of the attribute must be set.

May attributes: Double click the desired attributes to add them to the entry node. The

attributes listed in the May attributes field are optional.

Common attributes are listed in the following table:

Attribute Name Description
cn commonName Full name of the entry.
) First name also called Christian
gn givenName
name.
Surname, last name or family
sn surname

name.

telephoneNumber

telephoneNumber

Office phone number.

homePhone homeTelephoneNumber Home phone number.
mobile mobileTelephoneNumber | Mobile or cellular phone number.
pager pagerTelephoneNumber Pager telephone number.
company company Company name.
o organizationName Organization name.
ou organizationlUnitName Usual department or any sub

entity of larger entity.

Right click the selected attribute and then select Add value.

12
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The screenshot of adding a new entry is shown as below:

New enlry craation

Paant DN

Enfry RDS

Oopect chass (from schena)

jouwroles, domy

Onpect ches (manual)

1l‘ﬁ.l;ou

= ;|

& cn=tebe Tonouzionsdevalindeg

The value of cn here must be the same

o
L { . .
= eer s new vave | @S that of cn configured in the Entry
= objectCls .
person | [He RDN field.
- tukphonehurt
e | I
MUST attrbutes MAY attrbutes
@ T
m G
pijectCa seeAbo
description
Attrbute] when schemg Add
& unavatible)
Save _J Cancel

6. Click Save to confirm the configuration.

7.

Repeat steps 2 to 6 to add more contact entries.

You can find the added entries at the left of the LDAP catalogue.
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Microsoft Active Directory

Installing the Microsoft Active Directory Domain Services

This section shows you how to install an active directory on Microsoft Windows Server 2008 R2

Enterprise 64-bit system.

To install the Microsoft Active Directory Domain Services:

1. Click Start->Run.

2.

Enter dcpromo in the pop-up dialogue box and click OK.

13
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3.

4.

The Active Directory Domain Services Installation Wizard will appear after a short while,

click Next.

@1 Active Directory Domain Services Installation Wizard

Welcome to the Active Directory
Domain Services Installation
Wizard

This wizard helps you install Active Directory Domain
Services (AD DS) on this server, making the server an
Active Directory domain controller. To continue, click Next.

™ Use advanced mode installation

Leam more about the additional options that are
available in advanced mode installation.

More about Active Directory Domain Services

< Back [—N—m_>—| Cancel

Read the provided information and click Next.

@/ Active Directory Domain Services Installation Wizard

Operating System Compatibility
Improved securty settings in Windows Server 2008 and Windows Server 2008 B2 L= 1
affect older versions of Windows

—

Windows Server 2008 and "Windows Server 2008 R2" domain controllers have a
new more secure default for the security setting named "Allow cryptography algorithms
compatible with Windows NT 4.0." This setting prevents Microsoft Windows and
non-Microsoft SMB "clients” from using weaker NT 4.0 style cryptography algorithms
when establishing securty channel sessions against Windows Server 2008 or
"Windows Server 2008 R2" domain controllers. As a result of this new default,
operations or applications that require a security channel serviced by Windows Server
2008 or "Windows Server 2008 R2" domain controllers might fail.

Platforms impacted by this change include Windows NT 4.0, as well a5 non-Microsoft
SMB "clients" and network-attached storage (MAS) devices that do not support
stronger cryptography algorthms. Some operations on clients running versions of
Windows earierthan Windows Vista with Service Pack 1 are also impacted, including
domain join operations peformed by the Active Directory Migration Tool or Windows
Deployment Services.

For more information about this setting, see Knowledge Base aricle 342564
(http://go microsoft . com/fwlink/?Link|ld=104751).

« Back Next = Cancel

14
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5.

6.

Mark the Create a new domain in a new forest radio box and click Next.

@! Active Directory Domain Services Installation Wizard

Choose a Deployment Configuration

You can create a domain controller for an existing forest or for a new forest.

" Bxisting forest

| sdda domain contoller to an existing domain

" Create a new domait i &t existing forest
Thiz server will become the first domairn cantrollen in the: new domair:

%' Create a new domain in a new forest

More about possible deployment configurations

< Back Next > Cancel |

Enter an appropriate domain name for the forest root domain and click Next.

@! Active Directory Domain Services Installation Wizard

Name the Forest Root Domain
The first domain in the forest is the forest root domain. ks name is also the name of L= =
the forest. i

Type the fully qualified domain name (FQDN) of the new forest root domain.

FQDN of the forest roct domain:
|dap yealink.com

Example: comp .contoso.com

< Back Next = Cancel

15
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The wizard will check if the domain name is in use on the local network.

! Active Directory Domain Servi

MName the Forest Root Domain
The first domain in the forest iz the forest roct domain. ks name is also the name of

the forest.

Type the fully qualfied domain name (FQDN) of the new forest root domain.

FQDM of the forest root domain:
Idap yealink .

Example: comg
Verifying NetBIOS name...

<Back | MNet> | Canced |

7. Select the desired forest functional level from the pull-down list of Forest functional level,

and click Next.

For more information, click domain and forest functional levels.

@! Active Directory Domain Services Installation Wizard

Set Forest Functional Level
Select the forest functional level.

Forest functional level:
Windows Server 2003 j

Details:

e Windows Server 2003 forest functional level provides all features that are
vailable in Windows 2000 forest functional level, and the following additional
eatures:

- Linked-value replication, which improves the replication of

changes to group memberships.

- Mare efficient generation of complex replication topologies

by the KICC.
- Forest trust, which allows organizations to easily share LI

4

You will be able to add only domain controllers that are running
- Windows Server 2003 or later to this forest.

Mare about domain and forest functional levels

< Back Next > Cancel |

8. Select the desired domain functional level from the pull-down list of Domain functional

level, and click Next.
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For more information, click domain and forest functional levels.

@ Active Directory Domain Services Installation Wizard

Set Domain Functional Level
Select the domain functional level.

Domain functional level:

Details:

e features available at the Windows Server 2003 domain functional level include a
Il features available at the Windows Server 2000 domain functional level and the
ollowing additional features:
- Constrained delegation. which an application can use to take
advantage of the secure delegation of user credentials by
means of the Kerberos authentication protocal.
- lastLogon Timestamp updates: The lastLogonTimestamp attribute is
updated with the last logon time of the user or computer, and it is j

i You will be able to add only domain controllers that are running
Windows Server 2003 or later to this domain.

More about domain and forest functional levels

< Back Mext > Cancel

If you select Windows Server 2008 R2 for the forest functional level, you will not be
prompted to select a domain functional level.

The wizard will check if the DNS is properly configured on the local network.

! Active Directory Domain Servi

Set Domain Functional Level
Select the domain functional level.

Damain functional level:
Windows Server 2002 j

Details:

el include o
Examining DMS corfiguration. .. and the

e is

More about domain and forest functional levels

< Back Next = Cancel
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9. Select additional options for this domain controller if required, and click Next.

@! Active Directory Domain Services Installation Wizard

Additional Domain Controller Options

Select additional options for this domain controller.
¥ DNS server
¥ Global catalog
I Fead-only domain contoller (BODE]
Addttional information:

The first domain controller in a forest must be a global catalog server and ;I
cannot be an RODC.

We recommend that you install the DNS Server service on the first domain
controller.

Mare about additional domain cortroller options

< Back Next = Cancel

You may get a warning telling you that the server has one or more dynamic IP addresses. We
recommend assigning a static IP address to the server.

10. The wizard will prompt a warning about DNS delegation. Since no DNS has been

configured yet, you can ignore the message and click Yes.

@ Active Directory Domain Services Installation . x|

A delegation for this DMS server cannot be created because the
I 4, authoritative parent zone cannot be found or it does not run
~ Windows DNS server, If you are integrating with an existing DNS
infrastructure, you should manually create a delegation to this
DMS server in the parent zone to ensure reliable name resolution
from outside the domain petrilab.local, Otherwise, no action is
required.

Do you want to continue?

ey | ]

11. Specify the desired paths for the database, log files and SYSVOL folders, and click Next.

18



Installing and Configuring the LDAP Server

For more information, click placing Active Directory Domain Services files.

@ Active Directory Domain Services Installation Wizard

Location for Database. Log Fles. and SYSVOL
Specify the folders that will contain the Active Directory domain controller
database, log files, and SYSWVOL.

For better pefarmanice and recoverability, store the database and log files on separate

volumes.
Database folder:

Browse... |
Log files folder:
|C:\Windows\NTDS Browse... |
SYSVOL folder:
IC:\Windows\SYS\u"OL Browse... |

Mare about placing Active Directory Domain Services files

< Back Next > Cancel |

12. Configure the password for the active directory recovery mode, and click Next.

For more information, click Directory Services Restore Mode password.

The password should be complex and at least 7 characters long.

@ Active Directory Domain Services Installation Wizard

Directory Services Restore Mode Administrator Password

The Directory Services Restore Mode Administrator account iz different from the domain
Administrator account.

Assign a password forthe Administrator account that will be used when this domain
controller is started in Directory Services Restore Mode. We recommend that you
choose a strong password.

Password: I.o.o.o.o.

Confirm password: quuuo

More about Directory Services Restore Mode password

< Back Mext = Cancel

19
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13. Review your selection and click Next.

@ Active Directory Domain Services Installation Wizard

Summary

Review your selections:
Canfigure this server as the first Active Directory domain controllerin a new forest.  «

The new domain name is "ldap yealink.com”. This is also the name of the new
forest.

The NetBIOS name of the domain is "LDAP".
Forest Functional Level: Windows Server 2003
Domain Functional Level: Windows Server 2003
Site: Defautt-First-Site-Name

]

Ta change an option, click Back. To begin the operation, click Mext.

These settings can be exported to an answer file for use with Export settings. . |
other unattended operations.
More about using an answer file

« Back Mext > Cancel

The wizard will prompt that the system begins to create the Active Directory Domain

Services.

Active Directory Domain Services Installation Wizard

The wizard is configuring Active Directory Domain Services. This process can take
from & few minutes to several hours, depending an your environment and the options
that you selected.

Securing Kerberos Policy

Cancel

[ Reboot on completion

20
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14. Click Finish to complete the installation and exit the wizard.

@1 Active Directory Domain Services Installation Wizard x|

Completing the Active Directory
Domain Services Installation
Wizard

Wctive Directory Domain Services is now installed on this ;]
computer for the domain "ldap yealink.com".

[This Active Directory domain controller is assigned to the
site "Default-First-Site-Name". You can manage sites
with the Active Directory Sites and Services
administrative tool.

To close this wizard, click Finish.
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Installing Active Directory Lightweight Directory Services Role

You should also install the Active Directory Lightweight Directory Services role on Windows

Server 2008 system.
To install the Active Directory Lightweight Directory Services role:

1. Click Start->Administrative Tools->Server Manager.
2. Right click Roles, and then select Add Roles.
3. The Add Roles Wizard will pop up, click Next.
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4. Check the Active Directory Lightweight Directory Services checkbox and click Next.

.1..‘ Select Server Roles
Bebye np begn

Sact one o were (ks 10 B O\ s sesvey
L

L aiey
Coefrmaton 5
S . Ackve Dewcmory Pederabor Sarvess
o
” 4 Acrve Ceectory Lghbmnghe Deesiney Sovess
Senie Ak Deeonny Rghts Miregesent Serwces

Appication Server
DN Sarvwe
L oM Server

Hperd
L Netaark Polcy e Accens Sereas
[ Prevt and Docasertt Servces
Aewate Dediog Sorves
Weth Sevver T5)
Mrcas Depicyrent Lanicrs
Wirekoos Serrer Uncets Servioes

«vwea [ tets | | oo

U000 ek
L 1E med 2 Onete i t

x

Destrota:

Aearies o] reiced it servies
Mt odow yax b muae e owrepe
owtSicates gaed e 8 wataty of
aueatos

Ll T T
5. Follow the default settings and click Next.
6. When the installation is completed, click Close.

After the installation succeeds, you will find the Active Directory Lightweight Directory

Services role listed in roles of the server manager.
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Configuring the Microsoft Active Directory Server

Adding an Entry to the Active Directory

You can add entries to the active directory one by one in this way.

To add an entry to the Active Directory:

1. Click Start->Administrative Tools->Server Manager.

2. Double click Roles->Active Directory Domain Services->Active Directory Users and
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Computers.
3.

New->Organizational Unit.

Right click the domain name created above (e.g., Idap.yealink.com), and then select

=loix|
Eie-Ackn | Wew i Hsb IR |
e Zm 0|k = d]m |
i, Server Mansger (10215) Idap.yealink.com & /8l | Actions
-t T e —
= ¥ Active Drectory Domain Services ?
= ] Active Drectory Users and Computers [ y215.4dac Maore Actions. »
u;;’mmx Delegate Control...
¥ Active Drectory
& d Features Change Doman....
. Diagnostics Change Doman Controller,
%t Confiuraton Raise doman functionallevel.
@ [ Stocage Operations Masters. ..
| hee
Al Tasks.
View
Refresh
Export Ust...
o es
Help
< | i | 2
4. Enter the desired name of the organizational unit.
New Object - Organizational Unit x|
~ Cregtein:  Ildap yealink.com/
MName:
Iyealink|
¥ Protect container from accidertal deletion
oK I Cancel Help

5. Click OK to accept the change.
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6. Right click the organizational unit created above, and then select New->Contact.

[Eservermamaoer =lolx]
Fle Acton  View Helo
|[ew| n[m| & OIRED ol|@8[m
B Server Manager (110215)
S B hoes
= T Actve Drectory Domain Services
= T3 Actve Directory Users and Computers | Y0215 ks There are ro 2ems o sthow i i view More Actons 4
< 3 oo, yeaink.com
. . Bultn
* Computters
# 4 Doman Controlers
ForeignSeaurtyPrncpas
Maraged Service Accounts
Users
“ms Delegate Contrl..,
’;;‘amn,m Move...
aqun Fd...
C@terete TN o
v_‘Cu\h;.laM AS Tagks »
% storage = rr
e ¥, InetOrgPersan.
Gt melmaging P59
Delete MSMQ Queus Alas
Rename Organizational Unit
Refresh Prnter
Export Ust. User
Shared Folder
Fropertes
d Hep »ilal L 2
7. Enter the desired values in the corresponding fields.
New Object - Contact |

&) Create in:  |dap yealink com, ealink

First name: Isan Initials: Isz

Last name: Irhang
Full name: Isan sz. zhang
Display name: ||

o]

Cancel

8. Click OK to accept the change.

9. Double click the contact created above.
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10. Configure more properties of the contact.

san sz. zhang Properties e |

General |Flddr&ss| Telephones | Organization | Member Of |

& san sz. zhang

First name: I Initials: Isz

Last name: Iﬂﬂang

Digplay name: I

Description: I

Office: I

Telephone number: I Cther... |

E-mail: I

Web page: I Cther... |

11. Click OK to accept the change.
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Adding Entries to the Active Directory Using the Idifde Tool

You can use a LDIF file to perform a batch import of all entries to the active directory.

To create the LDIF file:

Create a new text document and then modify the filename extension as Idif. For example, create

a text document named as test.txt, right click the test.

txt document and then select to rename it,

modify the filename extension as Idif. Open the LDIF file with your favorite text editor and input

the corresponding content. The following shows an example of the content of the LDIF file:

##Create a new organizational unit##

dn: OU=yealink,DC=Idap,DC=yealink,DC=com
changetype: add

objectClass: top

objectClass: organizationalUnit

ou: yealink

name: yealink

##create a new contact##

changetype: add
objectClass: top
objectClass: person
objectClass: organizationalPerson
objectClass: contact
cn: san zhang

sn: zhang
givenName: san
initials: zs

name: san zhang
ipPhone: 2336
mobile: 15557107369

dn: CN=san zhang,OU=yealink,DC=Idap,DC=yealink,DC=com

To import the test.ldif file:

1. Click Start->Run.

2.

Enter emd in the pop-up dialogue box and click OK to enter the command line interface.
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3. Execute the command cd to access the path of the test.Idif file. For example, execute cd

c:\Windows to access the path of the test.Idif file at c:\Windows.

Copyright () 2 e % { ) All right reseresd,

C:NlgeraNidninizstratorded ¢ Window

c 2 \Windowa )

4. Execute the command Idifde -i -f test.Idif to import the file.

If the entries are added successfully, you can find the prompt “n entries modified

successfully” ("n" indicates the number of the added entries).

The screenshot for reference is shown as below:

T Admanistrator: G\Windows \system32 \cmed exe
soft Windows [(Version
ght (o) 28089 Microsoft or All rights reserved,

Wsers \Adninistratorded o “\Win

c 2 \Windows >1d if i test . 1dif
Connecting to b ldap.yealink.com'

Logging in as cur using SSPI

Inporting dirvectory from file "test.ldif"

Loading entriot
2 ontries modified succezsfully

The comnand has comploted suc

c 2 Windows )

You can also export the existing entries on the active directory into a *.Idif file first, modify the
file, and then import the modified file into the active directory. For more information, refer to
the network resource.

Adding Entries to the Active Directory Using the Csvde Tool

You can also use a CSV file to perform a batch import of all entries to the active directory. Create
a new document using a spreadsheet application (e.g., Microsoft Excel) and then save the
document to your local computer using “Save as” in the format “*.csv”. For example, create a
document named as test.xls, click “Save as” to save the document as test.csv. Open the CSV file
with the spreadsheet application and input the corresponding content. The following shows an

example of the CSV file content:

o objectClasy ou nuse en - givenNase ‘MU Cphane  subile
s

OU=yenlink, DC=1dsp, nrgssizationalbni

Deyonl Lok, DC“com L]

CH=sen

shang, 00=yenlink, BC

=1 dag, BCynnl ink, BC

yealisk yealink

contec! unn thang sen cthang san thang ax (388 12345685001

com
CN-wi
15, Ob-yealink, DOId contact wi M wh 1 H i =l nn 123456 TRS002
ap, DC=yeal ink, DC=co
CN=wu
wang, 00=ywal ink, BC

= oo comtect "y weng wu wang  weng w - 3333 1234567 R9000
1dap, BC<ywal ink, BC

com
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The first line lists the attributes of the entries.

The second line lists the values of an organizational unit in the corresponding attribute columns.

The other lines list the values of contacts in the corresponding attribute columns.

To import the test.csv file:

1. Click Start->Run.

2. Enter cmd in the pop-up dialogue box and click OK to enter the command line interface.

3. Execute the command cd to access the path of the test.csv file. For example, execute cd

c:\Windows to access the path of the test.csv file at c:\Windows.

T Adnanistrator: C\Windows \system3?

Microvoft n 6 7608

Copyright C(c) 2009 Mi % Corpavation, All right reserond,

CiNlgers Nidninizstratorded ¢ \Window

c 2 \Windowa )

4. Execute the command csvde -i -f test.csv to import the file.

If the entries are added successfully, you can find the prompt “n entries modified

successfully” ("'n" indicates the number of the added entries).

The screenshot for reference is shown as below:

"l

C:\Users A

4 entriecsn

Ihe comnan

c :\Windows >

dninistratordcd o2

nodif ied successfu

ration

d has completed suc

All right reserved

The csvde tool cannot edit or delete the existing entries on the active directory.

You can also export the existing entries on the active directory into a *.csv file first, modify the
file, and then import the modified file into the active directory. For more information, refer to

the network resource.

Creating User Accounts

You can create user accounts to allow access to resources on the active directory. User accounts

are very important and useful.
To create a user account:

1. Click Start->Administrative Tools->Server Manager.

2. Double click Server Manager->Roles->Active Directory Domain Services->Active
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3.
4.

5.

6.

Directory Users and Computers.

Select the domain name created above (e.g., Idap.yealink.com).

Right click Users, and then select New->User.

E_ Server Manager =101 %}
Fle Atwon Vew Heb
& 7[m[0IX 0o 8
T Server Manager (1LO215) Actions
= 3 Roes - .
= B9 Actve Drectory Doman Se [e - e e
5 T} Actve Drectory || & admnsvare  User Bultn account for adm.., Mece Actons »
S 3 \dap. yeaink.com 52, Alowed RO0.., Searity Group ... Members in ths growp can..,
% Buttn B, Cort Publshers  Security Grop ... Members of the grow ace...
3 ) Computers B Dened ROD... Secusity Growp ...  Members n thes group can..,
% @) Doman Control | #8 Doman Admns  Seaurity Growp ... Desgnated admnstators.
& ForeignSecunty | B8 Doman Com..,  Seanty Growp ... Al werkstatons and serve...
% ) Mansped Servw | 88, Doman Cont... Secuity Growp ... Al domain controllers in th..
T Guests  Seaurity Growp .. Al doman Quests
P A " A Users  Secunity Group ... Al doman users
‘;.M Acver) P A.. SearityGroup .., Desgnated admnstrators
22 Actve Drec Compuser . Members of the group ave.
3@ '"”“m Al Taks. »  Contact . Members n s group can..
& C:m“l\)t“»bm Y ” Growp Budtn account for guest
& ;Pjsmv InetOrgPerson . Serversin ths group can ..
o Refresh melmagng P55y + Members of ths group are.
Dxpor Qe Adas Sl atons.
2 Priter.
sisbed
el Shared Foider
o | 21|
Create a new cbject...

Enter desired values in the corresponding fields and click Next.

Mew Object - User |

& Create in:  Idap yealink .com/Users

Initials: Isz

First name: Isan
Last name: Izhang
Full name: Isan sz. zhang

User logon name:

IIdapuser‘l

User logon name (pre-Windows 2000):

I @dap yealink com j

ILDAF\

Ildapuser‘l

< Back

Mext = Cancel

Enter the password for the user, select the appropriate options and click Next.
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The password should be a combination of upper case letters, lower case letters, numbers

and special characters.

Mew Object - User x|

& Create in:  |dap yealink.com/Users

Password: In--nnn-.

Confirm password: Iuo.uuu..|

¥ User must change password at next logen
[~ User cannot change password

[~ Password never expires

[ Accourt is disabled

< Back MNexd = Cancel

7. Click Finish to complete the creation of the user account.

Hew Object - User |

z) Create in:  Idap yealink com/Users

When you click Finish, the following object will be created:

Full name: san sz. zhang ;l
User logon name: Idapuser] @ldap yealink.com

The user must change the password at next logon.

Microsoft Active Directory Application Mode

Microsoft Active Directory Application Mode (ADAM) is a new mode of Active Directory that is
designed specifically for directory-enabled applications. ADAM is a Lightweight Directory Access
Protocol (LDAP) directory service that runs as a user service, rather than as a system service. You

can run ADAM on servers and domain controllers running operating systems in the Windows
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Server 2003 family. This section shows you how to install Active Directory Application Mode
(ADAM) on Microsoft Windows Server 2003 SP2 Enterprise 32-bit system. You can download
Active Directory Application Mode (ADAM) online:

http://www.microsoft.com/en-us/download/confirmation.aspx?id=4201.

Installing the Active Directory Application Mode

To install the Active Directory Application Mode:

1. Double click ADAMSP1_x86_English.exe to run the application.

2. The Active Directory Application Mode Service Park 1 Installation Wizard will appear after a

short while, click Next.

|ge this wizard to install the following software update:

Active Directory Application
Mode Service Pack 1

Before you install this update, we recommend that wou;

- Back up your spstem
- Cloge all open programs

V'ou might need to restart vour computer after you complete
thiz update. To cantinue, click Mext.

< Back

Cancel

3. Read the software license agreement and mark I Agree radio box. And then click Next.

Software Update Installation Wizard

I’/
oy

License Agreement

Please read the following licenze agreement. To cantinue with setup,
you must accept the agreement.

MICROSOFT SOFTwWARE SUPPLEMEMTAL LICENSE il
TERMS

MICROSOFT ACTIVE DIRECTORY APPLICATION MODE
SERVICE PACK 1 FOR MICROSOFT WINDOWS SERVER
2003

Microzoft Corparation [or bazed on where pou live, one of its
affiliates] licenszes this supplement to vow. If you are licenzed to J
-

= | Do Mot Agree & Agies Frint |

< Back I Hest » I Cancel |
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The installation progress screen will be shown as below:

Software Update Installation Wizard

Updating Your System

]
HIU

Flease wait while setup inzpects vour current configuration, archives
your current filez and updates your files.

Finizhing installation

I

Details

Performing cleanup

< Back | Firish | Cancel I

4. Click Finish to complete the installation and exit the wizard.

Software Update Installation Wizard

Completing the Active Directory
Application Mode Service Pack 1
Installation Wizard

Yaou have successfully completed the ADAM 5P Setup
‘Wizard,

To close this wizard, click Finizh,

Camncel

< Back
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To create an ADAM instance:

1. Click Start->Programs->ADAM->Create an ADAM instance.

It will prompt the following interface and click Next.

.,';', Active Directory Application Mode Setup Wizard

Welcome to the Active Directory
Application Mode Setup Wizard

Thig wizard helpz you ingtall Microgoft Active Directom
Application Made [ADAK).

ADAM iz a powerful director zervice that is easy to install
and deploy. It provides a dedicated data store for
applications, and can be configured and managed
independertly.

To continue, click Mext.

< Back

Cancel Help

2. Mark the A unique instance radio box and click Next.

Active Directory Ap on Mode Setup

Setup Options
An ADAM instance iz created each time ADAM iz installed,

You can create a unique instance, of you can install a replica of an existing instance.

Select the type of instance you want to install
@

Thiz option automatically creates a new instance of ADAM that uzes the default
configuration and schema partitionzs. The new instance will not be able to replicate
with existing instances.

A replica of an existing instance

This option creates a new instance of ADAM that uzes the configuration and
schema partitions replicated from another ingtance of ADAM. Y'ou can also select
the application partitions to replicate.

< Back I Mest » I Cancel Help
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3.

4.

Enter the desired name in the Instance name field and click Next.

.,'?, Active Directory Application Mode Setup Wizard

Instance Name
The instance name is uged to differentiate this instance of ADAM fram other AD Ak
ingtances on this computer.

Type a name for this instance. The name should reflect the uze for which this instance
of ADaM is intended.

Inztance nane:

Example; Addressbook1

The ADAM zervice name iz created when the instance name iz combined with the
product name. It will be displayed in the list of Windows services.

ADAM service name:
ADAM_instancel

< Back I Mest » I Cancel Help

Keep the default ports and click Next.

Active Directory Application Mode Setup Wizard

Ports
Computers will connect to this instance of ADAM using specific ports on all of the
|P addreszes associated with this computer.

The ports displayed below are the first available for this computer. To change these
portz, tpe the new port numbers it the text boxes below.

available port numbers from the following range: 1025-E5535,

LDAP port nunnber:

SS5L port number:
E3E

IF pou plan to install Active Directom on this computer, do not uge 389 for the LDAP port
or 636 for the S5L port because Active Directony uzes these port numbers, Instead, use

¢ Back I Mest = I Cancel Help
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6.

Mark the Yes, create an application directory partition radio box and enter the desired

name (e.g., o=Yealink,c=CN) in the Partition name field, and then click Next.

.,'?, Active Directory Application Mode Setup Wizard

Application Directory Partition
An application directory partition storez application-specific data.

Do you weant to create an application directony partition for this instance of ADAKM?

Mg, do not create an application directory partition

Select this option if the application that you plan to ingtall creates an application directory
upon installation, or if you plan to create one later,

¢ ‘Yes, create an application directary partition

Select this option if the application that you plan to install does not create an application
directory partition upan inztallation. & valid partition name iz any distinguizhed name that does
not already exist in this instance. Example distinguizhed name:

CH=Partition1,DC= oodgrove, DC=COM

Partition nane:
o=ealink c=CH|

< Back I Mext > I Cancel | Help

Specify the desired paths for the data and data recovery files, and click Next.

¢= Active Directory Application Mode Setup Wizard

File Locations
ou can specify a location for each pe of file azsociated with thiz instance of
A0k

Specify the locations to store files associated with ADAM.

Data files:

Browsze. ..

C:4Program Fil

C:wProgram FilesiMicrosoft ADAMnstance \data Broweze.

[ ata recovery files:

¢ Back I Mext > I Cancel Help
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7. Mark the Network service account radio box and click Next.

Service Account Selection

ADAM performs operations using the permissions azsociated with the account pou
zelect,

Set up ADAM to perform operations wging the pefmizsions azzociated with the following account.

ghwark service account

ADAM has the permizsions of the default Windows service account.

" This account:

ADAM has the permizsions of the selected account. Ensure that the account you select is set
up ko Tun Az & service.

Wzer name: Iﬂ j J Browse,.. |

Basswond: I

< Back I Hext > I Cancel | Help |

It will pop up the following prompt box. Read the provided information and click Yes.

N Yo e set e & ssli servne orid for e AOGY euln, Decmon Hie comp e % 1ok 3 et of ) S Do sy et vt vl ot
s e

A 10 TRGRCAER W Mt AN R a0CS Dy T L3NGl 1o L S O AOR A

O pous wwrd by Lotros”

8. Mark the first radio box to assign the administrative permissions for ADAM to the currently
logged on user (e.g., USER-E5F3EA4782) and click Next.

.,'?, Active Directory Application Mode Setup Wizard

ADAM Administrators

Yau can specify the uzer or group that will have administrative privileges for this
instance of A0k,

Aszzign the following uzer or group of users administrative permiszions for ADAk.

' Currently lngged on user: USER-EBF3EA4 782 Administrator

The uzer that iz instaling ADAM will have administrative permizsions for this instance
of A0AM.

" This account

The selected user or group will have administrative permissions for this instance of
ADAM. You can choose any user or group from this computer, this computer's
domaiti, or any dormain that iz trusted by this computer's domain,

Sccount name;

Browse. . |
¢ Back I Hest » I Cancel | Help |
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9. Mark the Import the selected LDIF files for this instance of ADAM radio box.

10. In the Available files box, select the desired LDF files and then click Add->, and then click
Next.

t= Active Directory Application Mode Setup Wizard

Importing LDIF Files
“'ou can import data from Lightweight Directory Interchange Format (LDIF] files into
your ADAK application directory partition.

To configure the ADAM service in a specific way, import one or more of the LDIF files listed
below.

" Do not impart LDF files For this instance of A0
7 |mport the selected LDIF files for this instance of ADARM
Axailable files: Selected LDIF files:

b 587 an. LDF
MSnetdrgPerson LDF
b S-Usger LDF

M S serProsm LDF

<- Remove |

< Back | Ment > | Cancel Help

11. Review your selection and click Next.

.,';', Active Directory Application Mode Setup Wizard

Ready to Install
The ADaM SetupwWizard iz ready to install ADAKM with the following configuration.

Before continuing, review and confirm vour selections.

Selections:

Install & unique instance of ADAM. -

Instance name: ingtancel

Computers will connect to this instance of ADAM uzing the following ports:
LDAP port: 383

S5L port; 636

ADAM replication will uze Megatiate authentication,

Store ADAM program files in the following location: j

To change your selections, click Back. Taoinstall ADAM, click Mest.

< Back I Mest > I Cancel Help
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The installing progress is shown as below:

= Active Directory Application Mode Setup Wizard

Installing ADAM
The ADAM Setup Wizard is inztaling ADAM.

Installing ADAM. .

Flease wait whilz the wizard completes the following steps.
«f Copied files

[Configuring the local computer to host Active Directony

< Back et > | Cancel I Help

12. Click Finish to complete the installation and exit the wizard.

= Active Directory Application Mode Setup Wizard

Completing the Active Directory
Application Mode Setup Wizard

Yaou have successhully completed the Active Directary
Application Mode Setup Wizard,

Cance| Help

< Back
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Configuring the ADAM ADSI Edit

To configure the ADAM ADSI Edit:

1. Click Start->Programs->ADAM->ADAM ADSI Edit.

2. Click Action->Connect to.

D ALASY bt | K5 LA 1M )

\l/ Wk G AOAN LIN] T

A At S oy e B bl B AT B 0 e, iy i, Al SBESN  M Dlir . 30 b KM
L B B e A T PP T E—

Cimwel 4 (1 oty

3.  Enter the desired name (e.g., ADAML1) in the Connection name field.

4. Mark the Distinguished name (DN) or naming context radio box and enter the desired

value (e.g., o=Yealink,c=CN) in the following field.

5. Click OK.

Connection Settings E3 I

Connection name:

| aDam1
Server narme: Port
I localhost j I 359

Connect ko the Follawing node:
* Distinguished name (DM} of naming context:

I L=vealink,c=CM j
= well-known naming contesxt:
ICDnFiguration j

Connect using these credentials:
{* The account of the currently logged on user
€ This account:

Lser mame; Iﬂ j

Passward} I

Ok I Zancel |
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When the ADAM ADSI Edit connects an application directory partition (e.g.,

o=VYealink,c=CN) successfully, it will show as below:

G e e e M o wifti)
O Y@
éF [7!_ SR ™ S [
NOAN et 913) P e
ol Cmrnged e
o Mhelomhre® et

&l NI Cunn
® L0 Ok

To create the object for ADAM:

1. Select and right click O=Yealink,c=CN, and then select New->Object.

S e T

e e )
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2.

3.

Select organizationalUnit and click Next.

Create Object

Select a class;

container
counkry
domainDis
groupOfMames
inetOrgPerson
locality
organizationalPerson
: izationallinit

user
userProxy

= Barck I Mext = I Cancel |

Enter the desired value (e.g., oul) in the Value field and click Next.

Create Object

Attribute: ou

Synkax:  DirectoryString

yalue: |0u1|

= Back I Mext = I Cancel
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4.

5.

Click Finish to complete the creation of this object.

You can also click More Attributes to set more attributes for this object.

Create Dbject

To complete the creation of this object, click Finish.

To set more attibutes, click More Attributes.

< Back | Finish | Cancel

Select and right click OU=oul, and then select New->Object.

W e e e e
- LR - 200" B0 4 |
S hrurie -
el

(R

- -
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6.

7.

8.

Select user and click Next.

Create Object

Select a class:

conkainer

group

groupOfiames
inetCrgPerson

locality
msD3-AzAdminManager
organizationalPerson
organizationallnit

IEBI’SDH

userProxy

= Back I Mext = I

Cancel |

Enter the desired value (e.g., userl001) in the Value field and click Next.

Create Object
Attribute: cn
Syntax:  DirectoryString
Value: I user1001|
< Back I Mext = I Cancel
Click More Attributes to set more attributes for this user.
Create Dbject

To complete the creation of this object, click Finizh.

To set more attibutes, click More Attributes.

< Back Finish

Cancel
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9. In the popup dialog of Attributes, select the telephoneNumber from the pull-down list of
Select a property to view. Enter the desired telephone number (e.g., 1003) in the Edit
Attribute field and click Set. The entered telephone number will be shown in the Value(s)
field.

cn=userl1001 I

Attributes |

Path:

Class: user

Select which properties to view: IDptiDnaI j

Select a property to view: ItelephoneNumbel j

rAttribute Values

Syntag: ID irectomString

Edit Attribute: ||

Value(s): |1 003

10. Click OK to close the Attributes dialog, and click Finish to complete the creation of this

user.
11. Select and right click the user created above, and then select Reset Password.

12. Enter the password for the user created above in the New password field and Confirm

password field respectively.

i

Hew password: I******

Confirm password: I******

The account must log off and then log on again for the
change to take effect.

u):4 I Cancel

13. Click OK to accept the change.

If you want to use the user created above to manage and search information of LDAP, you need

to add the user to the administrator group in advance.
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To add the user to the administrator group:

1. Click ADAM1->0=Yealink, c=CN->CN=Roles.

S0 M e e 94 il
Lt AL BN 0 A
[ @ vt wid in
AN ot )
o) R . Protraate s, Theihey Cn roab e W
| ot Mootiunsy Chiniatin, OVt oty
2l J k1|

2. Select and right click CN=Administrators, and then select Properties.

W e v mEe e -
s> T >SS N
(S s> aree B (o I I — C
3 o e e e — |
3 it =% | —— be Sy ———
e - - — be e i, oot C-CB
- DT w
o Dl
 fine .
= .. 3 |
.l — 2%
C— Ty I g Sy P v Y T —
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3.

4.

Select the member attribute in the Attributes box and click Edit.

CH=Administrators Properties E E |]

Attribute E ditor |

¥ Show mandatory attibutes
¥ Show optional attributes

[ Show only attributes that have values

Edit |

Attributes:
Attribute | Syntax | Walue :I
fSMOR ole0wner Digtinguizhied ... <Mot Set:
groupT ype Integer -2147483646
inztanceT vpe Inteqer 4 J
izCriticalSystermObject  Boolean TRUE
izDeleted Boolean <Mot Setr
laztk nownParent Digtinquizhed .. <Mot Set
managedBy Distinguizhed ... <Mot Set
managedlbjects Distinguizhed ... <Mot Setr
maszteredBy Distinguizhed ... <Mot Setr
rnernbier Distinguished ... CH=&dministrat
rember0f Digtinguizhied ... <Mot Set:
modifyTimeStamp UTCCoded Ti...  3/28/2014 73642 AM
D S-Aporox-lmmed-..  Integer 1] _Iv
4 IS *

o ]

Cancel | Apply |

In the popup dialog of the member attribute,

Mol walued Distingusshed Narme Wath Secunty Prmogpol Eibtor

Mt bute Mokt

click Add ADAM Account.

. ]
A Wwwdoms Accourt l Romave
_qhddl(m leﬂ._._]
[ o I Carvel ]

46



Installing and Configuring the LDAP Server

5.

6.
7.
8.

Atrbuts: Resber

Vaes:

| Name Cordarme Tistingustwd Nama

| Admnatrators (S EASTC-3600-44 0507 1- 28000 CN=admristy stoes, OdeRoles, O onfigurat

Lrter & dnstmgushed name (D) For an obpect

[";—-r-vl‘i‘r' OU=Gul  om'raaink o=l
x I Canced
e | 2
Add Windowes Account
Add apam accort... |

Click OK to accept the change and close the dialog of adding ADAM account.
Click OK to accept the change and close the dialog of the member attribute.

Click OK to accept the change and close the Administrators Properties interface.

You can also view permissions of ADAM using the command.

To view permissions using the command:

1.
2.

Click Start->Programs->ADAM->ADAM Tools Command Prompt.

Execute the command dsacls \\localhost:389\o=Yealink,c=CN view permissions of

o=Yealink,c=CN.

wols Command Pramngt

Wind Unr

Capyrigin 2881 Micrese

VINDOME \ADAM >dsac ] localheas 189a~Yeallok,c
or CN“fAdninizstrator CN-R slink,.C-~CN
up N-fdninistrators, CN~Ho 2. 0"¥ealink C~CN

cn CN~NlaJos . CN~Canl igurat fon, CN~C(HBCE47C- 7608 -44A8-9871 - 283 1Da

SPFECIAL ACCESE
READ §
LIST INTE

K PFROPER

LIST OBJEC
Yealink, C~CN

SPECIAL ACCERS
READ i
LIST

HERD
LISY

fdninl ¥ o les , O-¥ealink,
Ll

ances ., . it fgurat fon, CN-CHECE492C-9680 I-9071 283108

Replicating Directory Chang

sonl iguration , CN~CHBCE477C - Y680 4448 - 9871 - 2 e

Repl tion ZSynchron
Cont lgurat HECE4AY'X

Manage Heplicat po logy
N-~Conl iguration.CN~{HSCI LR -44n8 ¢

Neplicating Directory Changes
sions inherited te subohbjects are:

writed t all subah
CM=Readers . CN=Ro les . 0-¥ealink, C=ON

1N

F3IDe

In the popup dialog of adding ADAM account, enter the desired dinstinguished name (e.g.,
CN=userl001,0U=o0ul,o=Yealink,c=CN) in the field.
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Sun One Directory Server

Sun One Directory Server, also known as Sun Java System Directory Server, is a component of
the Java Enterprise System. Sun One Directory Server can be installed on multiple platforms,
such as Windows, Linux, Solaris and so on. This section shows you how to install Sun One
Directory Server version 5.2 on Microsoft Windows Server 2003 SP2 Enterprise 32-bit system.

You can download it online: http://download.csdn.net/download/wbsoso/6439291.
Before the installation, you should prepare as follows:

e  Modify the hosts file of your computer.

° Install the Java Development Kit (JDK) 5 or later.
To modify the hosts file of your computer:

1. Locate the hosts file in the path "CAWINDOWS\system32\drivers\etc\hosts".
2.  Open and edit the hosts.dz file using your favorite text editor.

3. Add FQCN (Fully Qualified Computer Name) of your computer to the file. For example, the
FQCN of your computer is Idapsun.yealinktest.com. Add the following mapping:

127.0.0.1 Idapsun.yealinktest.com

Copyright (c) 1993-1999 Micreseft Corp.
This is & sample HOSTS fFile used by Micraosoft TCP/IP For Vindows.

This file contains the mappings of IP addresses to host names. Each
entry should be kept on an individual line. The IP address should

be placed in the first columa followed by the correspending host nane,
The IP address and the host name should be separated by at least one
space.|

Additionally, comnents (such as these) may be inserted on individual
lines or fFollowing the machine nane denoted by a “#° synbol,

For exanple:

102.56.94.97 rhino.acne.con B source server
38.25.63.10 X.aCcme . .con 8 x client host

127.9.0.1 localhost
P?I.D.DJ 1dapsun.yealinktest .con

4. Save the hosts file.

The following shows you how to install Java Development Kit (JDK) 6 on your computer. You can

download it online: http://www.oracle.com/technetwork/java/javase/downloads/index.html.
To install the Java Development Kit (JDK) 6:

1. Double click jdk-6u22-windows-i586.exe to run the application.
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2.

The Java (TM) SE Development Kit 6 Update 22 Installation Wizard will appear after a short

while, click Next.

ié‘ Java(TM) SE Development Kit 6 Update 22 - Setup

ORACLE’

Welcome to the Installation Wizard for Java™ SE Development Kit 6 Update 22

This wizard will guide you through the installation process for the Java SE Development
Kit 6 Update 22,

Cancel |

Click Change to locate the installation path from local computer system and then click

Next.

You need to remember the installation path (e.g., C:\Program Files\Java\jdk1.6.0_22)

located here.

The screenshot for reference is shown as below:

{& Java(TM) SE Development Kit 6 Update 22 - Custom Setup

1 Setup
ORACLE’

t the program Features you want installed.

Select optional features ta install from the list below. You can change your choice of features after
installation by using the Add/Remove Programs utility in the Control Panel

r~Feature Description

prent Tools. Javda(tTMz) SE Dle\;glopmgnt Kit SE
incluad 1V

s g?.u;?d:tezz’z. cThisnaiﬁrregtt;eJ

Source Code 300MB o your hard drive.

Public JRE

Java DB

Install to:

C:\Program FilesiJavaijdkl.6.0_22) change... l

< Back I Mext = “ Cancel I
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ava(TM) SE Development Kit 6 Update 22 - Progress

alling

The program Featur

Status: Extracting Installer

|§ Java Setup - Destination Folder

Destination Folder

ORACLE’

— Click "Change.,." torinstall Java to a different Folder

Java

Install to:

C\Program FilesiJavaljres), Change... I

Cancel I

Java Setup - Progress [ _ |

ORACLE’

Now you can have a full-featured office suite that’s
compatible with Microsoft Office for free!

e abne ; :
+ Reads, edits and saves Microsoft Office files
* Supports over 70 languages and Solaris, Windows, Linux and Mac operating systems
* Uses industry-standard, open file format (OpenDocument) as its default file format
* Built-in, one<lick PDF export

i Save

Wrster Calc Impress

7] Oﬁmice.om

Oraw Math
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4.

i’é Java(TM) SE Development Kit 6 Update 22 - Complete

ORACLE

Java(TM) SE Development Kit 6 Update 22 Successfully Installed

Product Registration is FREE and includes many benefits:
* Notification of new versions, patches, and updates

* Special offers on Sun products, services and training

* Access to early releases and documentation

When you click Finish, product and system data will be collected and the JDK product
registration Form will be presented. If you do not register, none of this information will
be saved.

For more information on what data Registration collects and how it is managed and
used, see the Product Registration Information Page.

Product Registration Information

Click Finish to finish the installation.

After the installation, you need to configure environment variables.

To configure environment variables:

1.
2.
3.
4.
5.
6.

Right-click the My Computer icon and select Properties.

Click the Advanced tab.

Click the Environment Variables button.

Add the following variables, click New under System Variables.

Enter the variable name as JAVA_HOME.

Enter the variable value as the installation path (e.g., C:\Program Files\Java\jdk1.6.0_22) for

the Java Development Kit.

Mew Sy=tem Yariable K
Yariable name: | nva_HOME
Wariable value: | C\Program Files\Javaljdkl .6.0_zz]
ok I Cancel |

Click OK.

Repeat the steps 4-7 to create a new system variable.

Variable name: classpath

Variable value: ;%JAVA_HOME%\lib\dt.jar;%JAVA_HOME%\lib\tools.jar

The dot "." stands for the current path and it can't be deleted.
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%JAVA_HOME% references the value of the specified JAVA_HOME variable created before.

Edit System Yariable EH ]

‘ariable name: | classpath

‘ariable walue: I [ ;960858 _HOME=E\bhdE, jar %618 A_HOME

[0]'4 I Cancel

9. Under System Variables, select the Path variable and click Edit.

10. In the Variable value field, append the Java bin directory (e.g., C:\Program
Files\Java\jdk1.6.0_22\bin) to the end of the existing path
(e.g., %SystemRoot%\system32;%SystemRoot%;%SystemRoot%\System32\Wbem;).
If the end of the existing path has no semicolon, you should add a semicolon to the end of

the existing path and then append the Java bin directory.

Edit System Yariable K
‘ariable name: I Path
‘ariable walue: I em;CH\Program Files)Javaljdkl.6.0_22\bin

K I Cancel

11. Click OK.
12. Click Apply Changes.

To verify the configuration of environment variables:

1. Click Start->Run.

2. Enter emd in the pop-up dialogue box and click OK to enter the command line interface.

ATINDOTSAsysten3Zicad. exe

Microsoft Windows [Version 5.2.37981
(C» Copyright 1785-28083 Microsoft Corp.

C:~Documents and Settings“Administrator’>

3. Execute the command java -version to check the java version.
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5.

It prompts the following information.

\TINDO¥S\system32\icad. exe

Microsoft Windows [Uersion 5.2.37981]
(C)> Copyright 1985-20883 Microsoft Corp.

C:\Documents and Settings\Mdministrator>java —version
Java version "1.6.6_22

l[Java<TM> SE Runtime Environment ¢huild 1.6.8_22-hB4)
lJava HotSpot(TM> Client UM <(huild 17.1-bhB3. mixed mode. sharing)

C:\Documents and Settings\Administrator>

Execute the command java to run the application.

It prompts the following information.

THDO¥S\systemn32icad. exe

C:\Documents and Settings\Administrator>java
Usage: java [-options] class [args...]
(to execute a class
oy Jjava [-options]l —jar jarfile [args...]
{(to execute a jar file)

wvhere options include:
—client to select the “client" UM
—server to select the "server' UM
—hotspot is a synonym for the Yclient"” UM [deprecatedl
The default UM is cli 3

—cp <{class search path of directories and zip/jar files>
—classpath {class search path of directories and zip/jar files>
separated list of directories, JAR archives.

and ZIP archives to search for class files.
—D<name >=<value>

set a system property
—-verhosel:classigcijnil

enahle verhose output
—yersion print product version and exit
—version:<{value>

require the specified version to run
—showversion print product version and continue
—jre—restrict-search | —jre—no—restrict-search

include/exclude user private JREs in the version sea
-? —help print this help message
= print help on non—-standard options
—eal:{packagename>...i:<{classname>]
—enableassertions[:<{packagename>...i:<{classname>]

enable assertions
—dal:<{packagename>...i:<{classname>]
—disableassertions[:{packagename>...i:{classname>]

< (o] - 3|

Execute the command javac to compile java files into class files.
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It prompts the following information.

ed

classpath

path s

Specify where to Fi

all debus
s no debugy i

pecify where to £i

|
o

ng
info

vhat the conpiler is deine

 where deprecated API re
nd user cloavy fFiler and annota
files and annota

nd user class

nd input
f boots

ource files

f ¥ ath

encoding
source <

r annotat

and/oy co

. INames of the annotation proce

OLAtion processor:

ted cl

Files

rated source Files

* 0r not to generats

varacter sncoding usasd by =

¢ compatibilicy

cla fFiles

urce files
cified reolea

file:

for

Ve
help
Ake yi-value ]

J<f lag>

Docunents and

Settings

infornation

Administrator>

Installing the Sun One Directory

To install the Sun One

Directory:

1. Unpack the compressed files named Sun Java System Directory
Server.5.2.P4.Windows.full.rar.

2. Double click setup.

exe to run the application.

3. The Sun Java(TM) System Directory Distribution Version 5.2 Install Wizard will appear after

a short while, click

@ Sun.

Next.

Waltamws

101 X

Wilcome % e Directory Berver nstalintion Progrsm, We strongly iecommena
ol you el 8 programs before tuaning this instalabion

Waming: Thiv peogram i robecing by copyight [aw and intermalions rsalies

TR DIOCIUCT 6 R0 UIA LND oY ACANARS (O 3NG 85 Uoe, LOpYING,
AAution, and decompiuion No et of 3 product may be reprocuced in sny
form by aery mean s wihout pnoe wilten suthor@atian of Sun Mcororystame, ini
00 88 Noonaon, (Fany, Unsuthored reproduchon or cksyibution of this
PrOQEumm, OF B ROMIum OF I, sy reoult In SEvers Ch and Crmine penalties,
A0 w00 Pros a0 uted to Ihe mstmum oxtont possibin urnder law

Cancel | Hep I
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4. Read the software license agreement and click Yes (Accept License).

¥ Yestell Wiverd

@ Sun.

{un Java(TH) Systom Direstory Server 5.2 formery IPIanet(TH) Direstory
Barvan

JIF YOL HAVE PAID IN FUILL ALL CORRESPONDING FEES AND CHARGES 1N
) ONNECTTON WITH A UCENSE FOR Sun Java(TH) System DIRECTORY

CUR EVALUATION LICENSE TO THE DIRECTORY SERVER IS SET FORTH o

5.  Enter the fully qualified name of the computer (e.g., Idapsun.yealinktest.com) in the Fully
Qualified Computer Name field and click Next.
The fully qualified name of the computer was planned before. For more information, refer

to modify the hosts file of your computer.

SF Eantaldd Winmd

@ Sun

Bach s | et » |
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6.  Mark the Sun Java (TM) System Servers radio box and click Next.

sn 5 2 Taniadl Tizsard

7.

¥ Tastall ¥Wiverd
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8.

9.

Specify the desired installation directory and click Next.

tory Histrikution Version & ¥ Tasiall Tisard

@Sun

C Program Fies\SunMPS

It prompts the following window. And you can click Create Directory to create the

directory or click Choose New to select another path.

Create a new directory?

yatlew Diree Lery Distribuiion Yersion 5 2 Instadl Ficasd ﬁr:r',

@ Sun
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10. Mark The new instance will be the configuration Directory Server radio box and click
Next.

5 2 Teatal) Vigesd

1.

5 ¥ Tastall Tesard
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12. Enter the value “Idapsun” in the Server Identifier field and keep the default values in other
two fields. And then click Next.

on 5.8 Tastall Fiawrd

£ |i=yealiskial decm
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14. Follow the default setting and click Next.

¥ Inatall Tixard

@ Sun

15. Configure the password for the Directory Manager and click Next.

The password must be at least 8 characters long.

T Lostadl Wirerd
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16. Check the Create Sample Organizational Structure check box and click Next.

s 5.7 Install Nizaed
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18. Follow the default settings and click Next for the following two steps.

strabution Versiaon 5 F Tastiall Tiserd

@ Sun

tribution Yersinn 5 3 Tastall Fidard
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19. View the items to be installed and click Install Now.

sz 5 ¥ Tastiall Yazard

@Sun

5.7 Install Fiseed

@ Sun
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After the installation, it will enter the configuring screen.

istribution Yersion 5 2 Instadl Fiams

5lapd-dapsung starng up senver
slapddapsung [2TMauZ014:1$ 44 11 +0800] - Sun Java(TN) System Oirectory S
slapdidapsung |27Mar2014,16 4412 +0200] - Listerung on all inferfaces port 28
slapd-ldspsung [2TMar2018:19 44.12 +0200] - slapd started

Out few directory server has been stared

eated new Direclory Sevver

Start Slapd Starting Stapd server configuration
Suceass Slapd Added Direcloty Seever information 10 Confguradon Sanver.

e C #on Directory Sener. dona

20. After the configuration, click Next to enter the installation summary screen. You can view
the directory sever installation status and click Details for more information. You can also

click Close to close the Sun Java(TM) System Directory Distribution Version 5.2 Install

Wizard.

@5us Java(TH) System Birectory Bistrihation Vernian & ¥ Tastall Tisaed

©Sun

Configuring the Sun Java(TM) System Server Console

Adding an Entry to the Directory Server

You can add entries to the Directory Server one by one in this way.

To add an entry to the Directory Server:

1. Click Start->Program->Sun Java(TM) System Server Products->Sun Java(TM) System

Server Console 5.2.
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It will enter the login screen. You should enter the administrator user name and its

password in the User ID field and Password field respectively.

User ID: |cn=Directory Manager

Passward:  frhiih

Administration URL: 'ﬂd‘tp:mdapsun.yealinktest.com:28512 LI

| gK I Cancel I Help I e

‘and all Sun and Sun Java(TV) System based
| logos are trademarks of Sun Microsystems, Inc

The system default administrator is cn=Directory Manager and its password which must be at
least 8 characters long has already been set during the installation process.

Then click OK to enter the home page.
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2.

3.
4.

Double click Idapsun.yealinktest.com->Server Group->Directory Server(ldapsun). It

will enter the Directory Tasks interface.

Sem Jave(TH) Zycton Bivacionry Serwwr -~ Llagans

Sun Java System Directory Serves

;g_' Slant Direclory Server
g] Stop Directory Server
_;2] Restart Directory Server
__2' Back up Directory Server
ﬁ] Restore Directory Server

g] Manage Cerificates

'3_’) | Log in to Directory Server as a new user

Click the Directory tab.

Select and right click the dc=yealinktest,dc=com (6 acis), and then select

New->Organizational Unit.

B ldegran yeslinktest com - Sum JeenOR) Systen Birnctary Sarver -~ Ldspinn

Somick R Yew Ctwct B

Tose | Corfgustes  Dvearory | 2oy

| T —p—— lb; Descxry Aovenerstors
- Gy domemunpie Arcom (3 RS S S
b 180 VS G Ecr
aal vape
R T o
53] Srmca Uners Ww Sttecio Bights.

g R
=] ¢ o

QD Swacheres (3 i)
v (3 ovevantor (5 0e)

b (g vty (4 ack) S Aczens Perrpetens . CurliL
- B
foel e 0E
Coveme Trrvwony rums
et 110,
ST
. " "
) Carlts
Ceey Cals
7 Pate sy
OSN3 e ) Guarlt
Brvemn cutn
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5.  Enter the desired name of the organizational unit.

“lrants How Organizstional Bnit |

'r-u:|m
bescrighon: |
Fhumc|

|

il

® InbCabed & ricuaned ekl

Acoest Permissers tob | | _gwen | e |

6. Click OK to accept the change.

7. Select and right click the organizational unit created above, and then select New->User.

PR VR Cmmy Bl (urlé) = o=l
Corecks £ £ v ey B
e
View Ettecove Wpts
e | I
P ttonn ye Ll T S o
| Cycees  DeAMaPendoton Curtel  OApewpRiondUne
[yscere  SeSuber L
o by Clgos O Smrece
14w ' ua
5 Daes Bowiryg fo0 Paszwena Pokey
35 T ]
3
Ly o Sarec
Q ovenc —
Lo o Cerlsr
Boveliony Cutie
Foate: Curlsy
Davin Cerkd)
Ezvem. Cheten

K 11|
Duaaul Sceywalritest domcor

67



Installing and Configuring the LDAP Server

8.  Enter the desired values in the corresponding fields.
T ¥
s 7
C— ...
NT U “Lngt Nema [t-.
Pooix User
Accourt * Common Nareedsx [ usert n
User 0 [
Paezaors P‘nnn-
Confrm Passwons Pau-o-u
B [ (#g, Urericomngany com)
prone [1c01
Fax |
* ndcmes & requred tekd
9. Click OK to accept the change.

You can view the user (User ID is ulin) created above under the organizational unit named ou2.

Hon Jurs (T8) Seatem Biractory Sarwer -

Lduprun

[ Mhapiun yewlrdtest (or 28511
B tomtiarwie AwiOm (2 ait)

* g ostitecweioct (3 e

QD orwschanes (5 acit)
» L onereonitoe (5 son)
* _“‘n:n-;-:nb) (a0
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Adding Entries to the Directory Server Using the Idifde Tool

You can use a LDIF file to perform a batch import of all entries to the Directory Server. For more
information, refer to create the LDIF file. The following shows an example of the content of the

LDIF file for the Directory Server:

##Create a new organizational unit##
dn: ou=ou3,dc=yealinktest,dc=com
ou: ou3

objectClass: top

objectClass: organizationalunit
creatorsname: cn=directory manager
modifiersname: cn=directory manager
parentid: 1

entryid: 15

entrydn: ou=ou3,dc=yealinktest,dc=com

##create a new user##

dn: uid=utest,ou=ou3,dc=yealinktest,dc=com
uid: utest

facsimileTelephoneNumber: 11002
givenName: user4

objectClass: top

objectClass: person

objectClass: organizationalPerson
objectClass: inetorgperson

sn: test

cn: user4 test
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To import the test.ldif file:

1.

In the home page of Sun Java(TM) System Server Console, double click

Idapsun.yealinktest.com->Server Group->Directory Server(ldapsun).

It will enter the Directory Tasks interface.

Sun Java~ System  Diraciory Server

Furn{Tl] Systom Birsctary Sarwer -

ka3

Ndnguun

EI Stop Direclory Server
| Restart Directory Server
EI Back up Directory Server
1| Restore Directory Server
EI Manage Cerificales

& | Log in to Direclory Serves as a new user

E' impor from LOIF

&1 Evoont 10 LOF

2. Click Import from LDIF.

It prompts the following dialog box.

xl

LD fhe (on conscke mackune) |
[~ aakd orty

7 Coetine o6 ervor

Fie for rejects: |

I I - |

3.

Click Browse to locate the test.Idif file from your local system, and then click OK.

x

LE# 1 {on conmoks machne) | C det b
I Aoty

¥ Contevse on eror

o |

Fhe tor repects |

L2 ] coma | 1o |
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After importing the test.Idif file, it will show the status of importing. If the entries are added
successfully, you can view the information “n objects imported, 0 objects rejected”. You can click

Close to close it.

S Import LDIF

Import finished.
2 objects imported, 0 objects rejected

Rejected objects:

You can view the imported the organizational unit (e.g., ou3) and user (e.g., uid=utest) under the

path: Directory-> dc=yealinktest,dc=com (6 acis).

B Ldepron. yoslinktest. com jan Javs (T8) Upsten Birsctory Nerwer ~ Ddspons

(nsse SR Yew (Neat tee

Sun Java™ System Disctory Sever

I kispmun pestextent oo 251 |
* ) deseangie doecom (3 aci)
+ () oeyealnkest doscom (0 sl
.f'.‘ Lt
:2;‘ People (5 son)
f‘: Spac Lvevy
3 a2
faa ot
It
¥ () Oehemscapefiat (3 see)
 Crwactnen (5 s00)
B (L) Comenirdis (£ 000)
L) emieedy (3 sen)
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Configuring Yealink IP Phones

LDAP is disabled on IP phones by default. You can configure LDAP via web user interface or

using configuration files.

LDAP Attributes on the Phone

Enable LDAP
Parameter Idap.enable
Description This parameter enables or disables LDAP feature on the IP phone.

0-Disabled (Default)
1-Enabled

LDAP Search

Parameter

Idap.search_type

Description

This parameter configures the search type for LDAP contact look up.
0-Prefix matching
1-Approximate string matching

If it is set to O (Perfect matching), the IP phone will search the LDAP
contacts that the phone number or name starts with the entered

character(s).

If it is set to 1 (Approximate string matching), the IP phone will search the
LDAP contacts that the phone number or name contains the entered

character(s).

LDAP Name Filter

Parameter Idap.name_filter

Description This parameter specifies the search criteria for names look up. The format
of the search criteria is compliant to the standard string representations of
LDAP search filters (RFC 2254). The "*" symbol in the filter stands for any
character. The "%" symbol in the filter stands for the name entered by the
user.

Example e ([(cn=%)(sn=%)(telephoneNumber=%))

When the cn or sn or telephoneNumber of the LDAP contact matches
the entered name, the record will be displayed on the phone LCD
screen.

° (&(cn=*)(sn=%))
When the cn of the LDAP contact is set and the sn of the LDAP

contact matches the entered name, the records will be displayed on
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the phone LCD screen.
({(cn=%))

When the cn of the LDAP contact does not matches the entered

name, the records will be displayed on the phone LCD screen.

LDAP Number Filter

Parameter Idap.number_filter

Description This parameter specifies the search criteria for numbers look up. The
format of the search criteria is compliant to the standard string
representations of LDAP search filters (RFC 2254). The "*" symbol in the
filter stands for any number. The “%" symbol in the filter stands for the
number entered by the user.

Examples e (|(telephoneNumber=%)(mobile=%)(ipPhone=%))

When the telephoneNumber or mobile or ipPhone of the LDAP
contact matches the search criteria, the record will be displayed on

the phone LCD screen.
(&(telephoneNumber=*)(mobile=%))

When the telephoneNumber of the LDAP contact is set and the
mobile of the LDAP contact matches the entered number, the record

will be displayed on the phone LCD screen.

LDAP TLS Mode

Parameter

Idap.tls_mode

Description

This parameter specifies the connection mode between the LDAP server

and the IP phone.

0-LDAP (Default)—Unencrypted connection between LDAP server and the
IP phone. (port 389 is used by default).

1-LDAP TLS Start—TLS/SSL connection between LDAP server and the IP
phone (port 389 is used by default).

2-LDAPs—TLS/SSL connection between LDAP server and the IP phone
(port 636 is used by default).

Note: It is only applicable to IP phones running firmware version 73 or

later.

Server Address

Parameter Idap.host

Description This parameter specifies the domain name or IP address of the LDAP
server.

Default Value | Blank

Example e 10.3.6.128
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es

e |dap.company.com

Port

Parameter Idap.port

Description This parameter specifies the LDAP server port.

Default Value | 389

Base

Parameter Idap.base

Description This parameter specifies the LDAP search base which corresponds to the
location in the LDAP directory. The search base narrows the search scope
and decreases directory search time.

Example e  dc=yealink,dc=com

Username

Parameter Idap.user

Description This parameter specifies the user name to login the LDAP server. If the
LDAP server allows anonymous to login, this parameter can be left blank.
Otherwise you need to provide the user name to access the LDAP server.
Note: If you use Microsoft Active Directory Application Mode (ADAM) as
the LDAP server, the user to login the LDAP server must be added to the
administrator group in advance.

Password

Parameter Idap.password

Description This parameter specifies the password to login the LDAP server. If the

LDAP server allows anonymous to login, this parameter can be left blank.

Otherwise you need to provide the password to access the LDAP server.

Max Hits (1~32000)
Parameter Idap.max_hits
Description This parameter specifies the maximum number of the search results to be

returned by the LDAP server. If the value of the "Max.Hits" is blank, the
LDAP server will return all searched results. Please note that a very large
value of the “Max. Hits" will slow down the LDAP search speed, therefore

the parameter should be configured according to the available bandwidth.

Default Value

50

LDAP Name Attributes

Parameter

Idap.name_attr

Description

This parameter specifies the name attributes of each record to be returned
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by the LDAP server. This parameter compresses the search results. The

user can configure multiple name attributes separated by space.

Example

cn sn displayName

non

This requires the “cn”, “sn” and “displayName” attributes set for each

contact record on the LDAP server.
givenName

This requires the "givenName" attribute set for each contact record
on the LDAP server.

LDAP Number Attributes

Parameter I[dap.numb_attr

Description This parameter specifies the number attributes of each record to be
returned by the LDAP server. This parameter compresses the search
results. The user can configure multiple number attributes separated by
space.

Example e mobile telephoneNumber ipPhone

"o

This requires the “mobile”, “telephoneNumber” and “ipPhone”

attributes set for each contact record on the LDAP server.

LDAP Display N

ame

Parameter Idap.display_name
Description This parameter specifies the display name of the contact record displayed

on the LCD screen. This parameter value must start with “%" symbol.
Example e  %cCn

The desired display name of the contact record is the cn attribute.

Protocol
Parameter Idap.version
Description This parameter specifies the LDAP protocol version supported on the

phone. Make sure the protocol value corresponds with the version

assigned on the LDAP server.
2-Version 2

3-Version 3 (Default)

LDAP Lookup For Incoming Call

Parameter

Idap.call_in_lookup

Description

This parameter enables or disables the phone to perform an LDAP search

when receiving an incoming call.
0-Disabled (Default)
1-Enabled
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uw,n ouwn

Note: If the caller number contains the special characters (e.g., “+", ".” or
the space), the phone will match the search criteria in the parameter
“LDAP Name Filter (Idap.name_filter)". If not, the phone will match the

search criteria in the parameter “LDAP Number Filter (Idap.number_filter)".

LDAP Lookup For Callout

Parameter

Idap.call_out_lookup

Description

This parameter enables or disables the phone to perform an LDAP search

when placing a call.
0-Disabled (Default)
1-Enabled

wono oo

Note: If the called number contains the special characters (e.g., “+", "." or
the space), the phone will match the search criteria in the parameter
“LDAP Name Filter (Idap.name_filter)". If not, the phone will match the

search criteria in the parameter “LDAP Number Filter (Idap.number_filter)".

LDAP Sorting Results

Parameter

Idap.ldap_sort

Description

This parameter enables or disables the phone to sort the search results in

alphabetical order or numerical order.
0-Disabled (Default)
1-Enabled

LDAP Special Search

Parameter

Idap.incoming_call_special_search.enable

Description

This parameter enables or disables the phone to search the telephone
numbers starting with “+" symbol and “00” from the LDAP server if the
incoming phone number starts with”+” or “00". When completing the

LDAP search, the all search results will be displayed on the LCD screen.
0-Disabled (Default)

1-Enabled

For example,

If the phone receives an incoming call from the phone number
0044123456789, it will search 0044123456789 from the LDAP sever first, if
no result found, it will search +44123456789 from the server again. The
phone will display all the search results.

Note: It works only if the value of the parameter “Idap.call_in_lookup” is
set to 1 (Enabled). You may need to set the value of the parameter
“Idap.name_filter” to be
(|(cn=%)(sn=%)(telephoneNumber=%)(mobile=%)) for searching the

telephone numbers starting with “+" symbol. It is only applicable to IP
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phones running firmware version 80 or later.

Configuring LDAP via Web User Interface

The followings take configurations of a SIP-T29G IP phone running firmware version 81 as

examples.
To configure LDAP feature via web user interface:

1. Press the OK key on the phone when it is idle to obtain the IP address.
2. Enter the IP address (e.g., http://192.168.0.10 or 192.168.0.10) in the address bar of web

browser on your PC and then press Enter.
3. Enter the user name and password in the login page.

The default login user name is admin (case-sensitive) and the password is admin

(case-sensitive).
4. Click on Directory->LDAP.
5. Select Enabled from the pull-down list of Enable LDAP.

6. Enter the desired values in the corresponding fields.
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[ 102,158
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Confym, CGince

7. Click Confirm to accept the change.
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Example for Web User Interface Configuration

You can use the following settings as a starting point and adjust the filter and display attributes

according to your requirements. The following shows example of OpenLDAP phone

configurations.

Enable LDAP: Enabled

LDAP Name Filter: (|(cn=%)(sn=%))

LDAP Number Filter: (|(telephoneNumber=%)(mobile=%)(ipPhone=%))
LDAP TLS Mode: LDAP

Server Address: 10.3.6.128

Port: 389

Base: dc=yealink,dc=com

Username: cn=Manager,dc=yealink,dc=com

Password: secret

Max Hits (1~32000): 50

LDAP Name Attributes: cn sn

LDAP Number Attributes: mobile telephoneNumber ipPhone
LDAP Display Name: %cn

Protocol: Version 3

LDAP Lookup For Incoming Call: Enabled

LDAP Lookup For Callout: Enabled

LDAP Sorting Results: Enabled

To use LDAP feature, you need to configure a DSS key as an LDAP key.

To configure an LDAP key via web user interface (not applicable to W52P/W56P/W60):

1. Log into the web user interface of the phone.

2. Click on Dsskey->Line Key (or Programable Key).
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3. Inthe desired DSS key field, select LDAP from the pull-down list of Type.
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4. Click Confirm to accept the change.

Configuring LDAP Using Configuration Files

To configure LDAP feature using configuration files:

1. Add/Edit LDAP parameters in the configuration file.

The following table shows the information of parameters:

Parameter Descriptions Web Setting Path

Idap.enable Directory->LDAP->Enable LDAP

Idap.search_type
(not applicable to
CP860/CP920 IP

phones)

) Directory->LDAP->LDAP Name
Idap.name_filter

These parameters Filter
specify the LDAP
. . Directory->LDAP->LDAP
Idap.number_filter attributes. Number Fil
Refer to the umber Filter
introduction above | Directory->LDAP->LDAP TLS
Idap.tls_mode
for more Mode
information. ]
Directory->LDAP->Server
Idap.host
Address
Idap.port Directory->LDAP->Port
Idap.base Directory->LDAP->Base
Idap.user Directory->LDAP->Username
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Parameter

Descriptions

Web Setting Path

Idap.password

Idap.max_hits

Idap.name_attr

l[dap.numb_attr

Idap.display_name

Idap.version

Idap.call_in_lookup

Idap.call_out_lookup

Idap.ldap_sort

Idap.incoming_call_spec

ial_search.enable

Directory->LDAP->Password

Directory->LDAP->Max Hits
(1~32000)

Directory->LDAP->LDAP Name
Attributes

Directory->LDAP->LDAP
Number Attributes

Directory->LDAP->LDAP Display

Name

Directory->LDAP->Protocol

Directory->LDAP->LDAP Lookup

For Incoming Call

Directory->LDAP->LDAP Lookup

For Callout

Directory->LDAP->LDAP Sorting

Results

2. Upload configuration files to the root directory of the provisioning server and trigger IP

phones to perform an auto provisioning for configuration update.

For more information on auto provisioning, refer to the corresponding auto provisioning guide:

For Yealink IP phones running old firmware version (old auto provisioning mechanism), refer to

Yealink SIP-T2 Series T19(P) E2 T4 _Series CP860 W56P IP Phones Auto_Provisioning_Guide.

For Yealink IP phones running new firmware version (new auto provisioning mechanism), refer

to Yealink SIP IP Phones Auto Provisioning Guide_ V81.
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Example for Configuration Parameters

You can use the following settings as a starting point and adjust the filter and display attributes

according to your requirements. The following shows example of OpenLDAP phone

configurations.

Idap.enable=1
Idap.search_type = 1

Idap.name_filter= (|(cn=%)(sn=%))

Idap.tls_mode=0

Idap.host= 10.3.6.128

Idap.port= 389

Idap.base= dc=yealink,dc=com

Idap.user= cn=Manager,dc=yealink,dc=com
Idap.password= secret

Idap.max_hits= 50

Idap.name_attr= cn sn

Idap.numb_attr= mobile telephoneNumber ipPhone
Idap.display_name= %cn

Idap.version= 3

Idap.call_in_lookup= 1

Idap.call_out_lookup=1

Idap.number_filter= (|(telephoneNumber=%)(mobile=%)(ipPhone=%))

Idap.ldap_sort=1

To use LDAP feature, you need to configure a DSS key as an LDAP key.

To configure an LDAP key using configuration files:

1. Add/Edit the LDAP key parameters in the configuration file.

You can configure a memory key, a line key or a programable key as an LDAP key. The

following table shows the information of parameters:

SIP VP-T49G/SIP-T48G/T48S: X ranges from 1 to
29;

SIP-T58V/T58A/T56A/T54S/T46G/T46S/T29G: X

ranges from 1 to 27;

phone.

Parameter Description Value
linekey.X.type
(not applicable to SIP-T19(P)
E2/CP860/CP920/W52P/W56P/W60 IP phones)
Configures a line key as
(CP960: X ranges from 1 to 30;
an LDAP key on the IP 38
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Parameter Description Value

SIP-T42G/T42S/TA1P/T41S: X ranges from 1 to
15;

SIP-T52S/T27P/T27G: X ranges from 1 to 21;
SIP-T40P/T40G/ T23P/T23G: X ranges from 1 to
3;

T21(P) E2: X ranges from 1 to 2)

programablekey.X.type
(not applicable for CP960/W52P/W56P/W60 IP

phones)

(SIP-T58V/T58A/T56A: X=12-14;

SIP VP-TA9G: X=1-4, 12-14; Configures a
programable key as an
SIP-T54S/T48G/T48S/T46G/T46S: X=1-10, 12-14; 38
LDAP key on the IP

SIP-T52S/T42G/T42S/T41P/T41S/TA0P/T40G:
X=1-10, 13;

phone.

SIP-T29G/T27P/T27G: X=1-14,
SIP-T23P/T23G/T21(P) E2: X=1-10, 14;
CP860/CP920: X=1-6, 9, 13)

2. Upload configuration files to the root directory of the provisioning server and trigger IP

phones to perform an auto provisioning for configuration update.
For more information on auto provisioning, refer to the corresponding auto provisioning guide:

For Yealink IP phones running old firmware version (old auto provisioning mechanism), refer to
Yealink SIP-T2 Series_T19(P) E2 T4 _Series CP860 W56P IP Phones Auto_Provisioning_Guide.

For Yealink IP phones running new firmware version (new auto provisioning mechanism), refer
to Yealink SIP IP Phones Auto Provisioning Guide_ V81.
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Using LDAP Directory on Yealink IP Phones

For SIP-T2 Series, T19(P) E2, T4 Series, T5 Series and CP
Series IP Phones

You can press the LDAP key to access the LDAP directory. Enter the desired numbers to match
the search criteria for searching a contact from LDAP directory, add local contacts from LDAP
directory, and dial a contact from LDAP directory. You can also enable the phone to perform an

LDAP search when receiving an incoming call or dialing an outgoing call.
To search a contact from the LDAP directory:

1. Press the LDAP key to access the LDAP search screen.

The LCD screen prompts “None”.

None

2. Enter a few continuous characters of the contact name or continuous digits of the contact

phone number using the keypad.

A Hebe Tian

The contacts which match the search criteria will appear on the LCD screen.

3. Press lx-{, or If::;- to select the desired contact.

4. Do one of the following:

- Press the Option soft key and then select Detail to view the detail information of the

contact.
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- Press the Option soft key and then select Add to Contact to add the contact to local.

- Press the Send soft key to dial out.

If the LDAP Lookup For Incoming Call parameter is enabled on the phone, the phone will
perform an LDAP search when receiving an incoming call. If there is a contact record which
matches the caller ID, the contact name will be displayed on the phone LCD screen as the calling

line identification.

The screenshot of the LCD screen for reference is shown as below:

<) Ringing

The Search Source List In Dialing feature enables the phone to perform an LDAP search when
you enter the digits using the keypad in the dialing interface. For more information on the
configuration of the Search Source List In Dialing feature, refer to Yealink phone-specific user
guide.

If there are contact records matching the search criteria, the contact records will be listed on the
phone LCD screen. You can select the desired contact record to dial out. The contact name will

be displayed on the phone LCD screen during the call.

The screenshot of the LCD screen for reference is shown as below:

EndCall
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If the LDAP Lookup For Callout parameter is enabled on the phone, the phone will perform an
LDAP search when dialing an outgoing call. If there is a contact record which matches the called

ID, the contact name will be displayed on the phone LCD screen as the called line identification.

The screenshot of the LCD screen for reference is shown as below:

<) Calling

2224 Hebe Tian
2500 5578

EndCall

For W52P/W56/W60 DECT IP Phones

You can access to the LDAP directory and enter the desired numbers to match the search criteria
for searching a contact, add local contacts from LDAP directory, and dial a contact from LDAP
directory. You can also enable the DECT phone to perform an LDAP search when receiving an

incoming call or dialing an outgoing call.

To search a contact from the LDAP directory:
1. Press OK->Directory->LDAP.
The LCD screen of handset displays the contact list.

2. Enter a few continuous characters of the contact name or continuous digits of the contact

phone number using the keypad.

The contacts which match the search criteria will display on the LCD screen.
3. Press A or V¥ to select the desired contact.
4. Do one of the following:

- Press the Options soft key and then select Detail to view the detail information of the

contact.
- Press the Options soft key and then select Add to Local to add the contact to local.

- Press % or uf todial out.

If the LDAP Lookup For Incoming Call parameter is enabled on the DECT phone, the DECT
phone will perform an LDAP search when receiving an incoming call. If there is a contact record
which matches the caller ID, the contact name will be displayed on the handset LCD screen as

the calling line identification.

The Search Source List In Dialing feature enables the phone to perform an LDAP search when
you enter the digits using the keypad in the dialing interface. For more information on the
configuration of the Search Source List In Dialing feature, refer to Yealink phone-specific user

guide.
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If there are contact records matching the search criteria, the contact records will be listed on the
handset LCD screen. You can select the desired contact record to dial out. The contact name will

be displayed on the handset LCD screen during the call.

If the LDAP Lookup For Callout parameter is enabled on the DECT phone, the DECT phone will
perform an LDAP search when dialing an outgoing call. If there is a contact record which
matches the called ID, the contact name will be displayed on the handset LCD screen as the

called line identification.

86



Using LDAP Directory on Yealink IP Phones

Customer Feedback

We are striving to improve our documentation quality and we appreciate your feedback. Email your

opinions and comments to DocsFeedback@yealink.com.
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